An Introduction to PebblePad

Using Pebble+ to create, share and publish an online portfolio

Edition 1 (Pebble+)
August 2013
Document Reference: 3779-2013
8. Formatting and customising your Webfolio .............................................. 52
   Formatting text in your Webfolio ......................................................... 52
      Task 8.1 Adding bold formatting to text ........................................... 52
      Task 8.2 Adding italics to text ......................................................... 53
      Task 8.3 Changing the colour of text ................................................. 53
      Task 8.4 Formatting the text style ..................................................... 54
      Task 8.5 Removing text formatting .................................................... 55
      Task 8.6 Formatting the remainder of your Webfolio .............................. 56
   Customising the appearance of your Webfolio ....................................... 57
      Task 8.7 Browsing and selecting asset banners ................................... 57
      Task 8.8 Creating a custom banner .................................................... 58
      Task 8.9 Creating a custom background ............................................. 61
      Task 8.10 Customising themes .......................................................... 62
      Task 8.11 Selecting and previewing banners ....................................... 64
      Task 8.12 Editing your customised theme .......................................... 65

9. The View menu ...................................................................................... 66
   Assets and the Asset Store ...................................................................... 66
      Task 9.1 Sorting your assets in the Asset Store .................................... 67
      Asset statuses in the Asset Store ....................................................... 68
      Task 9.2 Changing the status of an asset ............................................ 69
      Task 9.3 Searching the Asset Store .................................................... 71
   Contacts .................................................................................................. 72
      The Contact Manager ........................................................................... 72
      Task 9.4 Adding a new contact from your organisation .......................... 73
      Task 9.5 Adding an external contact ................................................... 75
      Managing your contacts ....................................................................... 76
      Task 9.6 Grouping your contacts ......................................................... 76
      Task 9.7 Organising your contacts ....................................................... 78
      Task 9.8 Deleting contacts or groups .................................................. 79
   Tags ......................................................................................................... 80
      Task 9.9 Adding tags to single and multiple assets ................................ 80
      The Tag Manager ................................................................................ 82
      Task 9.10 Add new tags using the Tag Manager .................................... 82
      Task 9.11 Renaming existing tags ......................................................... 83
      Task 9.12 Deleting tags ....................................................................... 84
      Hours and points .................................................................................. 85
      Task 9.13 Logging hours or points against an asset .............................. 85
1. Introduction

This workbook has been designed to provide you with the knowledge and skills necessary to use the Pebble+ software application. Through a variety of short exercises, you will learn how to create a basic online portfolio, known in Pebble+ as a Webfolio.

By creating a multiple page Webfolio, you will use many of the features available in Pebble+, before learning how you can share content with others, submit to an online Workspace, and publish your content to the web.

The exercises in this workbook require you to make use of some image files from the Pebble+ Workbook Files folder. The Pebble+ Workbook Files folder can be downloaded from the Pebble+ page of the IS Skills Development Documents Catalogue. The Documents Catalogue can be accessed from The University of Edinburgh website at http://edin.ac/12LqFoO

About Pebble+

Used by schools, colleges, universities and professional bodies, Pebble+ is a personal learning space which allows you to create, share and publish content. Pebble+ can be used by learners, teachers and assessors for personal development planning, teaching, assessment, and continuing personal development.

The software can be used to record achievements, learning records, personal goals and aspirations. Content created (known as assets) can be updated regularly, reviewed, shared with others, and published online.

Pebble+ privacy

Any content you create and store on your Pebble+ account can only be accessed by you, unless you share it with others. If you do decide to share any assets, you can set specific viewing and editing permissions for each individual asset when you decide to share it.

It is recommended that you always log out of your Pebble+ account when leaving your workstation. You should only ever share content with sources you trust, and are happy for them to see your work.
An Introduction to PebblePad

2. Accessing Pebble+

Pebble+ can be accessed through The University of Edinburgh’s web portal - MyEd. All staff members and students have access to Pebble+, and can log in through EASE - the University’s secure login system.

Task 2.1  Logging into Pebble+

Logging into Pebble+ through the MyEd portal is slightly different depending on whether you are logging in as a student or as a staff member. The following exercise focuses on logging in as a student.

To login to Pebble+ through MyEd as a student:

1. Open up a new web browser page.
2. Type https://www.myed.ac.uk/ into the address bar and press the Return key.

The University of Edinburgh’s web portal, MyEd will now load.

3. Click on the blue [login with ease] button under the Login to MyEd section of the portal.

The EASE login page will now be displayed for you to log in to using your UUN.

4. Type your EASE username (UUN) and password into the text entry fields.
5. Click the [Login now] button to log in.
An Introduction to PebblePad

You will now be logged into MyEd. From here you can access Pebble+.

6. Hover over the Studies tab on the menubar, and from the drop-down list, select **Pebblepad 3 / ATLAS**.

The Pebblepad 3 launch option will now appear.

7. Click on the [Launch Pebble+] button to launch the Pebble+ application.

You can also open the Accessible version by clicking the [Accessible version] button located below the [Launch Pebble+] button.
An Introduction to PebblePad

Pebble+ will now open in another web browser window with some information about the interface. This information will only appear the first time you open Pebble+.

8. Click [Close] to hide the on-screen information and begin using Pebble+.

If you have successfully logged into Pebble+, proceed to page 8 of this workbook.
An Introduction to PebblePad

To login to Pebble+ through MyEd as a staff member:

1. Open up a new web browser page.
2. Type https://www.myed.ac.uk/ into the address bar and press the Return key.

The University of Edinburgh’s web portal, MyEd will now load.

3. Click on the blue [login with ease] button under the Login to MyEd section of the portal.

Note: If you do not have an EASE account, click the register with ease button to register for an account.

The EASE login page will now be displayed for you to log in using your UUN.

4. Type your EASE username (UUN) and password into the text entry fields.
5. Click the [Login now] button to log in.
An Introduction to PebblePad

You will now be logged into MyEd where you can access the Pebble+ application.

6. Hover over the Studies tab on the menubar, and from the drop-down list, select Pebblepad 3 / ATLAS.

The Pebblepad 3 launch option will now appear on-screen.

7. Click on the Launch Pebble+ button to launch the Pebble+ application.

You can also open the Accessible version by clicking the Accessible version button located below the Launch Pebble+ button.
You will now have the option to login to PebblePad Classic or Pebble+

8. Click on the [Pebble+] button inside Pebble+ section of the window.

Pebble+ will now open in another web browser window with some information about the interface. This information will only appear the first time you open Pebble+.

9. Click [Close] to hide the on-screen information and begin using Pebble+.
An Introduction to PebblePad

3. The Pebble+ interface

The interface

The Pebble+ interface consists of four main sections; the quick links, menu bar, tools, and the main workspace area.

The image below shows how the interface will look the first time you log into Pebble+.

Quick link options

The quick link options allow you to access ATLAS, the Resource Centre and the Asset Store with a single click.

<table>
<thead>
<tr>
<th>Option</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATLAS</td>
<td><img src="image" alt="ATLAS" /></td>
<td>ATLAS is the institutional space, housing any Workspaces set up by tutors to manage activities and assessments.</td>
</tr>
<tr>
<td>Resource Centre</td>
<td><img src="image" alt="Resource Centre" /></td>
<td>Any templates you have created, or have had shared with you by other users are stored in the Resource Centre.</td>
</tr>
<tr>
<td>Asset Store</td>
<td><img src="image" alt="Asset Store" /></td>
<td>The Asset Store contains everything you have created or uploaded to Pebble+. It also contains any assets you have had shared with you by other users.</td>
</tr>
</tbody>
</table>

Each of these options can also be accessed from the main menu bar.

Both the Resource Centre and Asset Store will open in their own window within Pebble+, with ATLAS opening in a new web browser window.
An Introduction to PebblePad

Menu bar

The menu bar consists of five main menus, each of which can be used to create new or access existing assets. The menu bar can be found below the quick links section of the interface.

<table>
<thead>
<tr>
<th>Add New</th>
<th>Design New</th>
<th>View</th>
<th>Tools &amp; Resources</th>
<th>Settings</th>
</tr>
</thead>
</table>

Each of the menu bar options will open up a drop-down menu.

- **Add New**: Post, File, CV items, Plan, Experience, Reflection, Talent and View All.
- **Design New**: Activity Log, Blog, Collection, CV, Folio page and Webfolio.
- **View**: Assets, Contacts, Messages, My details and Tags.
- **Settings**: Notifications and Link to Google Drive.

The table below provides a brief description of the function each menu bar option performs.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add New</strong></td>
<td>The Add New menu is used to add new information, evidence and reflections to Pebble+. Information is added using templates, or by uploading files from your computer.</td>
</tr>
<tr>
<td><strong>Design New</strong></td>
<td>The Design New menu contains several options for building assets, allowing you to bring together items from your Asset Store or the internet.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Existing records and files are saved and managed via the Asset Store, which can be accessed from this menu. You can also manage and view contacts, tags, personal details and messages received from other Pebble+ users.</td>
</tr>
<tr>
<td><strong>Tools &amp; Resources</strong></td>
<td>The Tools &amp; Resources menu is used to access the Template Builder, allowing you to create your own personal templates to use within Pebble+. You can also access templates you have created or received from others form the Resource Centre, or access ATLAS.</td>
</tr>
<tr>
<td><strong>Settings</strong></td>
<td>You can use the settings menu to customise how you receive notifications from Pebble+. Other options may be available, depending on your role within your organisation.</td>
</tr>
</tbody>
</table>
An Introduction to PebblePad

Pebble\textsuperscript{+} tools

The Pebble\textsuperscript{+} tools are located above the menu bar on the right-hand side of the screen. These are the Information, Help and Logout buttons, shown below.

<table>
<thead>
<tr>
<th>Option</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information</td>
<td><img src="image" alt="i" /></td>
<td>The Information button is used to access information about Pebble\textsuperscript{+}.</td>
</tr>
<tr>
<td>Help</td>
<td><img src="image" alt="?" /></td>
<td>The Help button will take you to the Pebble\textsuperscript{+} and ATLAS help page. Both will open in a new page in your internet browser.</td>
</tr>
<tr>
<td>Logout</td>
<td><img src="image" alt="person" /></td>
<td>The Logout button will log you out of your Pebble\textsuperscript{+} session. It is advised that you log out using this button when you have finished your session to keep your work private and secure.</td>
</tr>
</tbody>
</table>
An Introduction to PebblePad

4. An introduction to Pebble+ tools

Several editing tools are available to you from the start of a new session, or as you start to create and share assets with other users.

The following table contains a brief description for each of the main tools available in Pebble+. These tools will be used when completing the exercises in this workbook.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Banners</td>
<td>To alter the appearance of your work in Pebble+, you can select a different asset banner for your asset, workbook or template.</td>
</tr>
<tr>
<td>Asset Editing and Previewing</td>
<td>Assets can be edited or previewed as you work on them, allowing you to see how your work should appear for viewers.</td>
</tr>
<tr>
<td>Asset Tabs</td>
<td>Asset Tabs allow you to view information about a particular asset, displaying alterations or edits you have made to them, with comments, feedback and links.</td>
</tr>
<tr>
<td>Do More Button</td>
<td>The Do More Button is a multipurpose button, and can be found on any open asset. This allows you to quickly share an individual asset with others, add a link and transfer the asset to another location.</td>
</tr>
<tr>
<td>Formatting Toolbar</td>
<td>The Formatting Toolbar is used to format any text contained within an asset. This can be used to add text links, asset links, email links, change the colour of text and apply general formatting.</td>
</tr>
</tbody>
</table>

Asset Banners

Asset Banners appear along the top of all assets, workbooks or templates in Pebble+. The banner for each asset can be changed, allowing you to select one from a range of Pebble+ default banners, or create your own using an uploaded image.

Editing and previewing assets

Each open asset contains a small group of options at the top right-hand side of the window, as highlighted below.

These options will change depending on the editing mode you are working in. For example, you can only preview an asset in full screen mode when you are working in preview mode.

The table on the following page contains a brief description for each of the edit and preview mode options.
An Introduction to PebblePad

<table>
<thead>
<tr>
<th>Option</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit this asset</td>
<td>![Pen icon]</td>
<td>The Edit this asset button will switch the asset into edit mode, allowing you to make and save changes. This option is only available in preview mode.</td>
</tr>
<tr>
<td>Save</td>
<td>![Save icon]</td>
<td>The Save button is visible when you are in edit mode. It is recommended you save your work regularly to avoid losing any content.</td>
</tr>
<tr>
<td>Preview this asset</td>
<td>![Preview icon]</td>
<td>The Preview this asset button will put the asset into preview mode, allowing you to see how your asset will look to viewers. This option is only available when in edit mode.</td>
</tr>
<tr>
<td>Full-screen preview</td>
<td>![Full-screen icon]</td>
<td>When you are in preview mode, you will be able to use the Full-screen preview button. This option will open your asset for viewing within a web browser window. You will be able to see how your asset will appear to those who view it via a share, Workspace or web link.</td>
</tr>
<tr>
<td>Close</td>
<td>![Close icon]</td>
<td>The Close button is visible on the toolbar when in both edit and preview mode. Having made changes, you will be prompted to save the asset if you try to close it without saving first.</td>
</tr>
</tbody>
</table>

Asset Tabs

Every asset in Pebble+ has additional options, located near the top right-hand side or at the bottom right-hand corner of the asset.

As you progress through this workbook to create your Webfolio, you will make use of some of these options.

The table on the following page contains a description of the Asset Tab options for any open asset.
An Introduction to PebblePad

<table>
<thead>
<tr>
<th>Option</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information</td>
<td><img src="image" alt="Info" /></td>
<td>Details about the asset including title, author(s), date of creation, tags, submissions and others can be found in the Information option. This option can also be used to edit tags, shares, publications and submissions.</td>
</tr>
<tr>
<td>Comments</td>
<td><img src="image" alt="Comment" /></td>
<td>Comments associated with the asset can be viewed and edited using the Comments option.</td>
</tr>
<tr>
<td>Feedback</td>
<td><img src="image" alt="Feedback" /></td>
<td>All feedback and grades associated with the asset can be viewed using the Feedback option.</td>
</tr>
<tr>
<td>Links</td>
<td><img src="image" alt="Link" /></td>
<td>The Links option allows you to view and delete any linked assets.</td>
</tr>
<tr>
<td>Tags</td>
<td><img src="image" alt="Tag" /></td>
<td>The Tag option allows you to add or remove tags for assets, as well as access the tag manager to edit existing tags.</td>
</tr>
<tr>
<td>Log Hours or Points</td>
<td><img src="image" alt="Log" /></td>
<td>The Log Hours or Points option allows you to access the activity logger window. You can add hours or points to specific assets based on your activity. These can then be tracked using an Activity Log.</td>
</tr>
</tbody>
</table>

**Do More Button**

The Do More Button is located at the top left-hand side of all assets, irrespective of which mode you are working in. The main use for this button is to allow you to quickly share the asset with others, submit to a Workspace, move the asset to another location or add links. The button appears visually different for each asset, but the function is still the same.

Below is how the do more button appears for both the Activity Log and Collection assets.

(Activity log) ![Activity log](image)  (Collection) ![Collection](image)

When you click on the Do More Button, a drop-down list appears. These options are Share, Submit, Add To, Link and Print:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share</td>
<td>The Share option allows you to share your asset with others. You can set specific permissions, restricting what recipients can do with your assets.</td>
</tr>
<tr>
<td>Submit</td>
<td>The Submit option is used to submit your asset to ATLAS.</td>
</tr>
<tr>
<td>Add To</td>
<td>The Add To option is used when you wish to add your asset to another asset, such as a Blog or Activity Log.</td>
</tr>
<tr>
<td>Link</td>
<td>You can link other assets to your work using the Link option.</td>
</tr>
<tr>
<td>Print</td>
<td>When the Print option is selected, the asset will open in a web browser and you will be given the option to print as a PDF file.</td>
</tr>
</tbody>
</table>

You will use the Do More Button later in this workbook to share your Webfolio with others and submit to an ATLAS Workspace.
An Introduction to PebblePad

Formatting Toolbar

The Formatting Toolbar allows you to make text bold, add italics, change the colour, add hyperlinks, and perform general formatting. The toolbar will appear above any highlighted text within an asset, as shown below.

The Formatting Toolbar includes the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td><img src="#" alt="Bold" /></td>
<td>Any selected text will become bold when this option is applied. Clicking again will remove any bold formatting from the selected text.</td>
</tr>
<tr>
<td>Italics</td>
<td><img src="#" alt="Italic" /></td>
<td>You can italicise any selected text using this option. Selecting the option again will remove italic formatting from the selected text.</td>
</tr>
<tr>
<td>Colour Options</td>
<td><img src="#" alt="Colour" /></td>
<td>The colour of your text can be changed using this option. Once selected, a small pop-up colour palette will appear. The selected colour will be applied.</td>
</tr>
<tr>
<td>Style</td>
<td><img src="#" alt="Style" /></td>
<td>You can apply various styles to your selected text using this option. A pop-up box will appear, from which you can select a heading/sub heading style to apply to the text, alter alignment, increase/decrease font size and sub/superscript text.</td>
</tr>
<tr>
<td>Asset Link</td>
<td><img src="#" alt="Asset" /></td>
<td>This option will open up your Asset Store, allowing you to link any stored asset to selected text. This will create a hyperlink to an asset, meaning when the user clicks on the text, the linked asset will open.</td>
</tr>
<tr>
<td>Web Link</td>
<td><img src="#" alt="Web" /></td>
<td>When clicked, a pop-up box will appear for you to enter a web address. When the text is clicked, the viewer will be taken to the web address.</td>
</tr>
<tr>
<td>Email Link</td>
<td><img src="#" alt="Email" /></td>
<td>When clicked, a pop-up box will appear for you to enter an email address. When the text is clicked, the user will automatically have a blank email generated with the recipient’s address already entered (depending on their email client settings).</td>
</tr>
<tr>
<td>Undo</td>
<td><img src="#" alt="Undo" /></td>
<td>Any selected text with formatting will be returned to normal (pre formatting).</td>
</tr>
</tbody>
</table>
An Introduction to PebblePad

5. Customising the Pebble+ interface

The first time you launch Pebble+, you will see the default interface. The background image will be of five stacked pebbles on sand, with a green menu bar.

When customising the interface, you can select a background image from the gallery, or upload your own image to the Asset Store. You can also specify the alignment of the image, change the background colour and change the colour of the menu bar options.

Your interface will not actually be visible to anyone viewing content you have shared with them; it is solely for your own viewing.

Task 4.1  Creating an interface theme

In the following exercises, you will change the interface image to an image from the Pebble+ gallery. You will then upload your own image to the Asset Store to use as your custom interface background image. You will also look at customising the colour of the menu bar.

To select an image from the default gallery:

1. Click on **Tools & Resources** from the menu bar.
2. From the drop-down list, click on **Customise Appearance** to open the **Create Interface Theme** window.
3. Click on the **Gallery** tab and select the image of the camper van in the field. Note that this selected image has a yellow border surrounding it.
4. Click [**Preview**] to see how the image will appear as your interface background.
5. Having previewed, click [**Go Back**] to return to the **Gallery** tab of the **Create Interface Theme** window.
An Introduction to PebblePad

To upload your own image:

1. Click on the Theme Builder tab of the Create Interface Theme window.
2. Click on the [Choose Image] button to open the Asset Store.

The Asset Store displays any assets which are available for use at this time. In this example, the Asset Store is empty as no images have been uploaded yet.

3. To upload an image, click [Upload]. This will open the Upload File window.
4. Under Title, type Surfing background, and under Description, type Surfing image for the Pebble+ interface background.

Once your image has been uploaded, it will be saved in your Asset Store. Entering a title and description for any uploaded content can be especially helpful if you are sharing assets with other users.

5. Click [Browse] to locate the image file for your interface background. From the Pebble+ Workbook Files folder, open the Sporting Events folder and select Surf 2.
6. Click [Open] to select this file for upload.

7. Tick the checkbox to confirm you are entitled to upload this image file.

Note: Always ensure that you have permission to use any image(s) you wish to upload to Pebble+. Many websites allow you to use images for free, providing you reference them. Others will allow for free use without reference.
8. Click [Save & Upload] to begin the file upload to the Asset Store.

Your image will now be processed and uploaded to the Asset Store.

9. Once the upload has finished, click the Close button on the Upload File window. The Asset Store will now update to display your newly added image.

10. Select the image from the Asset Store, and click [Confirm].

Your uploaded image will now appear inside the Create Interface Theme window.

11. Click [Save and Close] to use this image as your new background.

If you do not want to use this as your background image, click Close, followed by [Close] when the Save changes dialog box appears.
An Introduction to PebblePad

To change menu bar colour:

1. Reopen the Customise Appearance window from the Tools and Resources menu.
2. Under Background Image Position, select Fill.
3. Within the Menu Bar Options section, click inside the box next to Colour.
4. When the colour palette appears, select the colour you wish to use for the menu bar.
5. Click [Preview] to see how the interface looks with your changes.
6. Click on the [Go Back] button.
7. Click [Save and Close] to save your changes.

If you do not want to save your changes, click Close [x], followed by [Close] to cancel any colour changes you have made to the menu bar.
6. The Add New menu

The Add New menu allows you to create new assets to add to your Asset Store, or share with your contacts. Assets you can create include Posts, Files, CV Items and Records of Learning.

In the following exercises, you will use the options within this menu to create some content for your Webfolio.

Posts

A Post is a single asset which can contain a simple piece of text or media content such as videos or images. Posts are most commonly used to quickly store a thought or small piece of information.

Task 6.1 Creating a new Post

You are now going to create a short Post for your Webfolio, which will contain both text and media content. This Post will then be added to the Blog section of your photography Webfolio.

To create a new Post:

1. Click on Add New from the menu bar.
2. From the drop-down menu, select Post.

A new Post will now open in its own window.
An Introduction to PebblePad

You can resize the Post by clicking and dragging the **Resize** button, located at the bottom right of the window. This option is used to resize all assets in Pebble.

3. In the **Post Title** box, type *Just got myself a “new” camera!*

4. In the **Content** box, type the following text:

   *I bought myself a new camera today. Well, I say “new” but it is in fact pretty old! Anyway, here is a little picture of it.*

   *Hopefully I will manage to take lots of good photographs on it to add to this site!*

   *I will keep you posted, so keep an eye out for some pics!*
Task 6.2 Adding a new section to your Post

Now that you have created a Post with text, you are going to add an image to it from the Asset Store.

**To add an image to your Post:**

1. Below the Content section, click on the [Add New Section] button.
2. From the Layout tab, select the fourth option, Media Content.
3. From the newly created section, click on [Choose Media File...].
4. From the Asset Store, click on [Upload]. This will open the Upload File window.
5. In the Title section, type My New Camera, and in the Description section, type Image of my new camera.
6. Click [Browse] and locate the file My New Camera from the Pebble+ Workbook Files folder.
7. Check the permission box and click [Save & Upload].

As before, your image will be resized and processed for upload.

8. Close the Upload File window.
9. Click on the My New Camera file in the Asset Store, followed by [Confirm].

Your image will now be added to the section below the text you previously entered.

10. From the top right-hand corner of the Post, click on the preview this asset option to preview your Post. You can also make use of the full screen preview option to preview your Post in full screen mode.

Previewing your assets will give you an idea as to how they will appear when viewed by any users they are sent to.
An Introduction to PebblePad

Task 6.3     Arranging the content within your Post

As you have added the text and image separately to your Post, you now have two individual sections. When working in edit mode, you can change the order of these sections, or remove them completely from the Post.

To change the order of the sections within your Post:

1. Click the edit this asset option at the top right of the Post to enter edit mode.
2. Click anywhere inside the image section.

Four options to move or remove this section will now appear at the top of this section.

3. Click on the move up option to move the image section above the text section.

Your image will now be positioned above the text in your Post.

You can also use the move down option to move a section down, or you can click and drag the move option to move the section up or down. To remove a section from the Post, click the Remove button.

4. Click preview this asset to preview your Post within Pebble”.
5. Click edit this asset, followed by Save.

Your Post will now be saved to the Asset Store.
File Upload

The File option in the Add New menu will open the Upload File window, the same window used when uploading an image for both the interface background and Post. If you have several images you wish to add to your Asset Store for use at a later date, you can add them individually using this option. The process of uploading files is exactly the same as it was in Task 4.1 when you uploaded an image to create your own interface theme.

Plan, Experience, Reflection and Talent

Plan, Experience, Reflection and Talent (often referred to as PERT) are the four categories of records you can create using templates in Pebble+®. These templates can be accessed through the Add New menu, and can be used to create plans and document activities.

<table>
<thead>
<tr>
<th>Category button</th>
<th>Template button</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Plan]</td>
<td>![Action Plan]</td>
</tr>
<tr>
<td>![Experience]</td>
<td>![Activity]</td>
</tr>
<tr>
<td>![Experience]</td>
<td>![Meeting]</td>
</tr>
<tr>
<td>![Experience]</td>
<td>![Experience]</td>
</tr>
<tr>
<td>![Reflection]</td>
<td>![Journal Entry]</td>
</tr>
<tr>
<td>![Reflection]</td>
<td>![Structured Reflection]</td>
</tr>
<tr>
<td>![Talent]</td>
<td>![Ability]</td>
</tr>
<tr>
<td>![Talent]</td>
<td>![Achievement]</td>
</tr>
</tbody>
</table>

In addition to these templates, you can also create your own or make use of any templates which have been shared with you by other users.
An Introduction to PebblePad

Task 6.4 Creating a Record

You are now going to create a new Journal Entry record to add to your Webfolio using the default Journal Entry template.

To create a Journal Entry using a template:

1. Click on Add New from the menu bar.

2. From the drop-down list, select Reflection, followed by Journal Entry.

A new Journal Entry template asset will now open.

3. In the Title box, type Attended ‘Photography for beginners’ workshop.

4. In the About This Entry box, type I recently attended a workshop to teach me the basics of photography.

5. In the Reflection box, type I have learnt how to set-up my camera properly, work with objects, set-up lighting and the basic rules of photography.

6. Click Save, followed by Close.

Your Journal Entry asset will now be added to your Asset Store. You will add this asset to your Webfolio later in this workbook.
7. The Design New menu

The Design New menu provides several options which can be used to build new assets or bring together existing assets from within the Asset Store. This menu contains six options; Activity Log, Blog, Collection, CV, Folio page and Webfolio.

<table>
<thead>
<tr>
<th>Option</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Log</td>
<td><img src="image" alt="Activity Log" /></td>
<td>The Activity Log allows you to combine several assets relevant to a specific project. This is useful if you wish to demonstrate activity on a specific task over a period of time. If any assets have had time or points assigned to them, the activity log will create a running total of these. This is particularly helpful when working towards a specific goal or target.</td>
</tr>
<tr>
<td>Blog</td>
<td><img src="image" alt="Blog" /></td>
<td>You can use a Blog to record any activity, for example, a placement or project you have been involved in. Blogs are created from Posts and other assets, with content arranged in chronological order.</td>
</tr>
<tr>
<td>Collection</td>
<td><img src="image" alt="Collection" /></td>
<td>A Collection is a single page list containing assets based on their search criteria. As you create and add new assets to your store, you can filter and add them to your Collection using the key words, data ranges or tags.</td>
</tr>
<tr>
<td>CV</td>
<td><img src="image" alt="CV" /></td>
<td>The CV option can be used to create a CV in Pebble™. CV items are created and stored in the Asset Store, before being used to create a CV.</td>
</tr>
<tr>
<td>Folio page</td>
<td><img src="image" alt="Folio page" /></td>
<td>The Folio page can be used to present information about activities you have participated in, personal learning and development, your personal profile, or any other subjects. This single page portfolio is a useful way of displaying evidence of activities, and can include links to assets in your store, links to items on the internet and multimedia content. There is no limit to how many Folio pages can be created.</td>
</tr>
<tr>
<td>Webfolio</td>
<td><img src="image" alt="Webfolio" /></td>
<td>A Webfolio is a multiple page portfolio made from two or more assets. You can add and edit additional pages, templates and Folio pages to your Webfolio, which is a great way of collating and presenting evidence and information. There is no limit as to how many Webfolios you can create.</td>
</tr>
</tbody>
</table>
An Introduction to PebblePad

Blogs

A Blog can be constructed from Posts or other records within Pebble\(^*\), and can be used to record any time based or on-going activity. Any Posts created in or added to a Blog can be ordered by date created or posted. They can also be ordered by latest or oldest.

Task 7.1 Creating a new Blog

You are going to create a new Blog and add the Post you created earlier to it. You will add this Blog to your Webfolio at a later stage.

To create a new Blog:

1. Click on Design New from the menu bar.

2. From the drop-down menu, select Blog. This will open the Blog and the Blog Properties window.

3. Under the Title section of the Blog Properties window, type Welcome to my blog.

4. Under the Short Description section, type You will find any updates, new photos, equipment, techniques and general chat on this page. You can make use of the ‘add a comment’ option too!

5. Click Close \(\times\) at the top right-hand corner of the Blog Properties window to close this window.

Text entries in the Blog Properties window will appear in the Blog window in real time as they are typed.

6. Now click Save \(\boxed{\text{Save}}\) and leave the Blog open on-screen.
An Introduction to PebblePad

**Task 7.2 Adding a new Post to a Blog**

Now that you have created your Blog, you can add a Post to it. You can add both new and existing Posts to any Blog.

*To add a new Post to a Blog:*

1. From within the **Blog** window, click on [New Post] to create a new **Post**.

2. In the **Post Title** section, type **Hello! Welcome to my new webfolio blog!**

3. In the **Content** section, type **This is my first blog entry for my new webfolio! Plenty more to come soon!**

4. Click [Save & Add].

This Post will now be added to your Blog, as highlighted below.

You can edit or remove a Blog entry using the **edit entry** and **remove entry** options, highlighted above.

5. Leave your **Blog** open on-screen for now.
An Introduction to PebblePad

Task 7.3 Adding an existing Post to a Blog

In this exercise, you are going to add your recently created Post (about your new camera) to your Blog.

To add an existing Post to a Blog using the Asset Store:

1. From the menu bar, select View, followed by Assets. This will open the Asset Store.

2. In the Category pane on the left-hand side of the window, click on Posts. This will filter your assets to display only Posts.

3. Select the Post titled Just got myself a “new” camera!

4. Click [Add To] from bottom of the window.

5. From the pop-up menu, select Blog.
The Asset Store will now display any created or shared Blogs to which you can add your selected Post.

6. Click on the Blog titled *Welcome to my blog!*.  

7. Now click on the [Confirm] button.

This Post will now be visible in your Blog above your previously entered Post. If you cannot see your Post, click the *Refresh* button at the top right-hand corner of the Blog.

8. Now *Save* and *Close* your *Blog*.

You can also add an existing Post to your Blog using the Do More Button.
An Introduction to PebblePad

To add an existing Post to a Blog using the Do More Button:

1. From the menu bar, select View, followed by Assets. This will open the Asset Store.

2. In the Category pane on the left-hand side of the window, click on Posts. This will filter your assets to display only Posts.

3. Select the Post titled Just got myself a “new” camera.

4. Click on the [View] button at the bottom of the Asset Store.

5. Now click on the Do More Button at the top left-hand corner of the Post.

6. From the drop-down list, select Add To, followed by Blog.

7. From the Asset Store, click on the Blog titled Welcome to my blog!

8. Click the [Confirm] button.

9. Click [view blog] to view your Blog with the newly added Post.
Task 7.4  Altering the Blog properties

Now that you have added some content to your Blog, it is time to define the order your Posts will be displayed within the Blog.

By default, the Blog properties are set to display Posts by date, with the most recent Post displayed first.

To alter the properties of your Blog:

1. Click on the *edit this asset* button to put your Blog into edit mode.

2. Click on the *manage properties* option at the top right-hand side of the *Blog* window.

This will open the *Blog Properties* window.

The Blog Properties window allows you set how your Posts are arranged and displayed.

3. Ensure that *Use ‘posted on’ Date* and *Display Latest First* are both checked.

4. *Close* the *Blog Properties* window and the *Blog* window.

Posts will now be displayed with the most recently added Post at the top of the Blog, followed by older Posts.
An Introduction to PebblePad

Collections

A Collection is a single page list of assets, compiled using specific search criteria including tags, dates, keywords or asset types.

You are now going to create four new Collections, containing different groups of images. Each of these Collections will then be linked to the portfolio page of the Webfolio using a text-based link.

Task 7.5 Uploading images to the Asset Store

Before creating these Collections, you will need to upload the images for this exercise.

Upload the image files from the Pebble* Workbook Files folder:

From the Pebble* Workbook Files folder, upload the images from the table below. Enter the text which appears in the third column of the table as the Title for each.

<table>
<thead>
<tr>
<th>Pebble* Workbook Files folder name</th>
<th>Image File Name</th>
<th>Name to enter as Title in Pebble*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sporting Events</td>
<td>Golf 1</td>
<td>Golf 1</td>
</tr>
<tr>
<td>Sporting Events</td>
<td>Golf 2</td>
<td>Golf 2</td>
</tr>
<tr>
<td>Sporting Events</td>
<td>Golf 3</td>
<td>Golf 3</td>
</tr>
<tr>
<td>Sporting Events</td>
<td>Golf 4</td>
<td>Golf 4</td>
</tr>
<tr>
<td>Sporting Events</td>
<td>Golf 5</td>
<td>Golf 5</td>
</tr>
<tr>
<td>Sporting Events</td>
<td>Surf 1</td>
<td>Surf 1</td>
</tr>
<tr>
<td>Sporting Events</td>
<td>Surf 2</td>
<td>Surf 2</td>
</tr>
<tr>
<td>Sporting Events</td>
<td>Surf 3</td>
<td>Surf 3</td>
</tr>
<tr>
<td>Sporting Events</td>
<td>Surf 4</td>
<td>Surf 4</td>
</tr>
<tr>
<td>Sporting Events</td>
<td>Surf 5</td>
<td>Surf 5</td>
</tr>
<tr>
<td>Locations</td>
<td>Loch Lomond 1</td>
<td>Loch Lomond 1</td>
</tr>
<tr>
<td>Locations</td>
<td>Loch Lomond 2</td>
<td>Loch Lomond 2</td>
</tr>
<tr>
<td>Locations</td>
<td>Loch Lomond 3</td>
<td>Loch Lomond 3</td>
</tr>
<tr>
<td>Locations</td>
<td>Loch Lomond 4</td>
<td>Loch Lomond 4</td>
</tr>
<tr>
<td>Locations</td>
<td>Rome 1</td>
<td>Rome 1</td>
</tr>
<tr>
<td>Locations</td>
<td>Rome 2</td>
<td>Rome 2</td>
</tr>
<tr>
<td>Locations</td>
<td>Rome 3</td>
<td>Rome 3</td>
</tr>
<tr>
<td>Locations</td>
<td>Rome 4</td>
<td>Rome 4</td>
</tr>
<tr>
<td>Locations</td>
<td>Rome 5</td>
<td>Rome 5</td>
</tr>
<tr>
<td>Music Events</td>
<td>Concert 1</td>
<td>Concert 1</td>
</tr>
<tr>
<td>Music Events</td>
<td>Concert 2</td>
<td>Concert 2</td>
</tr>
<tr>
<td>Music Events</td>
<td>Concert 3</td>
<td>Concert 3</td>
</tr>
<tr>
<td>Music Events</td>
<td>Concert 4</td>
<td>Concert 4</td>
</tr>
<tr>
<td>Music Events</td>
<td>Concert 5</td>
<td>Concert 5</td>
</tr>
<tr>
<td>Music Events</td>
<td>Concert 6</td>
<td>Concert 6</td>
</tr>
<tr>
<td>Music Events</td>
<td>Concert 7</td>
<td>Concert 7</td>
</tr>
</tbody>
</table>
Once you have uploaded each of the images listed in the table on the previous page, check that they are visible in the Asset Store. You may need to refresh the window to see them.

**Task 7.6 Creating a new Collection**

Now that you have uploaded the images to the Asset Store, it is time to create the collection assets to store them in.

*To create a new Collection:*

1. From the menu bar, select Design New, followed by Collection.

The Collection window will now open alongside the Collection Properties window.

2. Under Collection Title, in the Collection Properties window, type Golf Photos.

3. Under Short Description, type Below are some golf related photographs. Click on the underlined text next to the blue icons to open each photo in your web browser.

As before, text entered in the properties window will appear in the asset window as you type.


5. Click on the [Select Assets] button to add some images. The Asset Store will automatically open.
An Introduction to PebblePad

6. From the Category pane on the left-hand side of the Asset Store, click on Media to display only media assets.

7. To select all golf image assets at once, click on Golf 5, hold the Shift key, and click on Golf 1.

8. Click on the [Add Selected] button at the bottom of the window.

The golf image assets you selected will now be added to your Golf Photos Collection.

You can use the [Remove] button to remove all assets within a specific section of the Collection. The [Select Assets] button at the bottom of the Collection window can also be used to add more assets to your Collections.

9. Now Save and Close the Collection window.

10. Create another three Collections for the surf, locations and concert images stored in the Asset Store.

11. Open the Asset Store (View > Assets) and under Category, click on Designs to display any design assets. This is where your newly created Collection assets will appear.

If you can’t see your Collections, click the Refresh button to refresh the Asset Store.

12. Now Close the Asset Store and any other windows you have open.
An Introduction to PebblePad

Webfolios

A Webfolio is a multi-page portfolio constructed from two or more assets. The Webfolio can be used as an online portfolio to showcase your work through web links, media, Blogs, Posts and other assets. You can add, edit or remove pages, assets and templates, making it a flexible and versatile way to collate and present information. You can create and share as many Webfolios as you wish.

The Webfolio will be used to form the basis of your online portfolio in this Workbook.

In this section of the workbook, you are going to create your own Webfolio and add some new and existing assets to it.

Task 7.7 Creating a new Webfolio

In this exercise, you will create a new Webfolio asset from the Design New menu.

To create a new Webfolio:

1. From the menu bar, select Design New, followed by Webfolio.

The Webfolio and Webfolio Properties windows will now open side by side.

2. In the Please Enter a Title For This Webfolio section of the Webfolio Properties window, type *insert name here* Photography. For example, you could type Ben Smith Photography.

3. In the Please Enter a Description For This Webfolio section, type An online portfolio for amateur photographer *insert name here*.


7. The Design New menu
An Introduction to PebblePad

Adding pages to your Webfolio

Now that you have created your Webfolio, it is time to add some new pages and assets to it.

In the following exercises, you are going to learn how to add new and existing pages to your Webfolio. These will include a home page, about me, portfolio, blog, useful information, journal and contact pages.

Task 7.8  Adding a ‘Home’ page

The home page is the first page users will see when your Webfolio is opened. It will contain an image and some simple text.

To add a ‘Home’ page to your Webfolio:

1. Click on the [New Page] button within the Webfolio window.

2. In the Navigation Title For This Folio page section of the Folio page Properties window, type Home.

3. In the Title For This Folio page section, type Welcome to my photography portfolio....

4. In the Description For This Folio page section, type ...Please feel free to look around....
5. From the **Layout** tab (highlighted above), click on the fourth option, **Media Element**. This will allow you to add an image asset to this page.

6. Click **Choose Media File…**, and from the **Asset Store**, select the image titled **Loch Lomond 3**.

7. Click **[Confirm]**.

8. Change the size of the image using the **Resize** option at the bottom right-hand corner of the image (highlighted below). Click and drag to increase or decrease the size of the image.

9. Click the **edit this asset** option, followed by **Save** to save your current Webfolio.

---

**Note:** I have also included a short message regarding the use of images in my Webfolio. You don’t have to worry about including this message in your home page description; it is simply for your information.
An Introduction to PebblePad

Task 7.9 Adding an ‘About me’ page

The about me page will be used to give viewers a short insight into you and your Webfolio. The about me page is created in the same way as the home page.

To add an ‘About me’ page to your Webfolio:

1. Click on the New Page option, located on the left-hand side of the Webfolio window (highlighted below).

2. In the Navigation Title For This Folio page section of the Folio page properties window, type About me.

3. In the Title For This Folio page section, type A little bit about me….

4. In the Description For This Folio page section, type Hi there, welcome to my online portfolio!

5. Close the Folio page properties window.

6. From the Layout tab of the Webfolio window, select the second option, Text area with left aligned media element.

7. Click on Choose Media File… to open the Asset Store.

8. Click [Upload] to open the Upload File window.

9. Under Title, type About me page image, and under Description, type This is the image to be used on the About me page.
10. Click [Browse] and from the Pebble* Workbook Files folder, upload the file named About me page image.

11. Check the box to state that you are entitled to use this image, and click the [Save & Upload] button.

12. Close the Upload File window.

13. From the Asset Store, select the About me page image asset and click [Confirm].

14. In the text entry box to the right of the media element, type a short piece of information about yourself. For example, you could type something similar to this:

   Hi and welcome to my page...

   My name is Andy Todd and I am an amateur photographer from Fife. I have recently taken up photography, and decided to create this folio to show my progression from the beginning to.....well to where ever I manage to end up!

   Mainly as a hobby, I enjoy taking pictures of nice locations, sporting events, music concerts and wildlife.

   Using the navigation section on the left-hand side, you can move through my folio to see some examples of my work, read my blog entries and make contact with me.

   Thank you for visiting, I hope you enjoy your stay.

   Andy

After you have entered your text and added an image, the about me page of your Webfolio will begin to take shape.

15. Whilst still in edit mode, Save your Webfolio.
An Introduction to PebblePad

Task 7.10 Adding a ‘Portfolio’ page

The portfolio page of your Webfolio will be created using a new blank page, like the home and about me pages. This time however, you will create a text-based link to each of the Collection assets to allow the user to navigate to the Collection assets from the portfolio page.

To add a ‘Portfolio’ page to your Webfolio:

1. Ensure you are in edit mode by clicking the edit this item option at the top right-hand corner of the Webfolio window.
2. Click on the New Page option below the navigation menu. The Folio page Properties window for this new page will open alongside the Webfolio window.
3. In the Navigation Title For This Folio page section of the Folio page Properties window, type Portfolio.
4. In the Title For This Folio page section, type My Portfolio.
5. In the Description For This Folio page section, type Below is a collection of photographs taken from around the world. These photographs include scenery, sporting events and concerts.

Please feel free to comment on any of the images and let me know what you think!

6. Click Close to close the Folio page Properties window.
7. From the Layout tab of the new page in the Webfolio window, click on the second option, Text area with left aligned media element.
8. Click Choose Media File..., and select Surf 5 from the Asset Store.
9. Click [Confirm] to add this media element.
10. In the text entry box to the right of your image, type Click here to view some of my surfing photos.

The portfolio page of your Webfolio should now look similar to the image below.
An Introduction to PebblePad

11. Now follow steps 8–10 again, but this time alternate between using *Text area with left aligned media element* and *Text area with right aligned media element* within the *Layout* tab.

12. Add *Golf 4* as the media element to the second section, and type *Click here to view some of my golf related photos* in the text entry box to the left of the image.

13. Finally, add *Concert 1* as the media element to the third section, and type *Click here to view some of my concert photos* in the text entry box to the right of the image.

With sections created and added, the portfolio page of your Webfolio should look similar to the screenshot below.

The next stage is to add text-based links which will open the relevant image Collection asset when clicked.
An Introduction to PebblePad

Task 7.11 Adding a ‘Blog’ page

Having added a portfolio page with images to your Webfolio, you are now going to add the Blog you created earlier.

This time, instead of creating a new page for your blog, you are going to add an existing asset (Blog) to your Webfolio.

To add your existing Blog to your Webfolio:

1. Click on the Blog option located under the navigation menu.

2. From the Asset Store, select the Blog titled Welcome to my blog!, and click [Confirm].

Your selected Blog will now be added to your Webfolio, with the Asset Page Properties window opening alongside the Webfolio window.

As highlighted above, the button on the navigation bar for the blog will have automatically assumed the title previously entered for your blog - Welcome to my blog!; however, we would like it to be titled Blog.

3. In the Asset Page Properties window, click on the page tab.

4. Under Navigation Title For This Folio page, delete the text Welcome to my blog!, and type Blog.

The navigation button name will now change.

5. Save your Webfolio and Close the Asset Page Properties window.
An Introduction to PebblePad

Having added your Blog to your Webfolio, you are now going to add a new Post. This will let viewers know that you have added some new photos to the portfolio page of your Webfolio.

This time, instead of creating a new Post using the Add New menu, you are going to use the new Post button inside your blog page.

To add a new Post from within your Blog:

1. Within your Webfolio, click on the [New Post] button at the left-hand side of the Blog page.

2. When the new Post opens, type I've just uploaded some new pictures! into the Post Title section, and type I've added some new photos to my portfolio. You can click here to view them. As always, your feedback is appreciated! into the Content section.

3. Highlight the word here to display the Formatting Toolbar.

4. Click on the Asset Link option.

5. From the Asset Store, select the Folio page titled My Portfolio.

6. Click [Confirm].

7. Click on the [Add New Section] button, and from the Layout section, select Media element.

8. Click on Choose Media File... to open the Asset Store.

9. Select Surf 3 from the list of image assets.

10. Click [Confirm] to add the surfing image asset to your Post.

11. Click inside the section with the image, and click the move up option to move your image above the text.

12. Click the [Save & Add] button to add this Post to your Blog.

13. In the Blog page of your Webfolio, click on the read more... option (below your new Post) to view your new Post in more detail.
An Introduction to PebblePad

14. Click on your text link to verify it works correctly. Once clicked, the *My Portfolio Folio page* asset should open.

When users click on this link when your Webfolio is shared with them, it will open the single portfolio page (Folio page asset) in a new tab of their web browser.

**Task 7.12 Adding a ‘Journal’ page**

You are now going to add a journal page to your Webfolio. You can use the journal to document events directly relevant to you. Events could include courses, sessions, training workshops or seminars.

The journal page will make use of the Journal Entry asset you created earlier in the workbook, currently stored in the Asset Store.

*To add a ‘Journal’ page to your Webfolio:*

1. From within your *Webfolio* window, click on the *Existing Asset* option.

2. When the *Asset Store* opens, select your *Journal Entry* asset titled *Attended ‘Photography…*.

3. Click [Confirm] to add your Journal Entry as a new page.

The *Webfolio* and *Asset Page Properties* windows will open side by side. The navigation button for this new page is titled *Attending ‘Photography for beginners’ workshop*.

4. In the *Asset Page Properties* window, delete the text *Attended ‘Photography for beginners’ workshop* and replace it with the text *Journal*.

This change will update in real time within the Webfolio. Once the change has taken place, the navigation menu should look similar to the one below (right).

5. **Close** the Asset Page Properties window, and **Save** your Webfolio.
Task 7.13  Adding a ‘Contact’ page

The final part of your Webfolio is the contact page. You can enter some details on this page to allow users to contact you. This page will make use of text-based links.

To add a ‘Contact’ page:

1. Click on the New Page option at the left-hand side of the Webfolio window.

2. In the Navigation Title For This Folio page section of the Folio page Properties window, type Contact.

3. In the Title For This Folio page section, type Contact.

4. In the Description For This Folio page section, type the following:

   You can contact me using either the postal address, phone number or email address listed below. Please feel free to contact me with any question, queries or if you just fancy a chat.

5. Close the Folio page Properties window.

To add content to your ‘Contact’ page:

1. From the Layout tab, select the Text area option to create a text entry area.

2. Click inside the text entry box and type the following:

   Post:

   You can contact me by mail at:

   {Insert your name}
   {Insert a postal address}

3. Click on the Text area option again to create another text area.

4. This time, type the following:

   Phone:

   You can contact me by phone on:

   Tel:   {Insert a landline number}
   Mob:   {Insert a mobile number}

5. Click on the Text area option once more to create the final text area.

6. In this area, type the following:

   Email:

   You can also contact me by email. To do so, click here.
An Introduction to PebblePad

Your contact page will now have 3 main sections each containing various contact methods.

Click on the *preview this asset* option to gain a better idea of how this asset will appear when viewed by another user or recipient. You can also use the *full screen preview* option to see how your full Webfolio will appear for viewers. Your Webfolio will open in a new web browser when you use this option. At this point your Webfolio will be saved automatically.

7. Keep your Webfolio open for the next task.
Creating text-based links

PebblePad allows you to create several types of text-based links, including links to assets, websites and new emails. These text links work in the same way as hyperlinks in documents or on web pages.

Task 7.14  Text-based asset links

You are now going to create text-based links for your portfolio page. These links will open your Collection assets individually in a new web browser.

*To create a text-based asset link:*

1. Open the *Portfolio* page of your *Webfolio* in *edit mode*.

2. In the first text entry box (surfing photos), highlight the word *here*. The *Formatting Toolbar* will appear above the selected text.

3. From the *Formatting Toolbar*, select the *Asset Link* option \( \text{Asset} \). This will open the *Asset Store*.

4. From the *Asset Store*, locate and select your *Surfing Photos Collection*.

5. Click the [Confirm] button.

The text you highlighted and added the link to will now be coloured blue and underlined. This is how the linked text will appear to users who view your portfolio.

Having created the text link, it is recommended that you test it to confirm that it links to the correct Collection.

6. At the top right corner of the *Webfolio* window, click on the *preview this asset* option \( \text{Preview} \).

7. Click on the text *here* (linked text) to open your link.
An Introduction to PebblePad

The Surfing Photos Collection window will now open in a different window within Pebble+. The images below show the Webfolio window (left) and the Surfing Photos Collection (right).

8. Switch to edit mode using the edit this asset option at the top of the Webfolio.

9. Now link the other sections of your portfolio to the relevant Collections, using the text here as the text base link for each.

Having created text links for each of the three sections, your portfolio page should look similar to the one below.

Any available asset within the Asset Store can be linked to any text selection using the Asset Link option.
An Introduction to PebblePad

Task 7.15  Text-based email links

Now that you have added your contact page, you are going to set up a text-based email link. This means that when the user clicks on the word here in the email section of your contact page, a new email with your address will be created in MS Outlook (if their mail client is MS Outlook).

To create a text-based email link:

1. Open the Contact page of your Webfolio in edit mode.
2. In the Email section, highlight the word here.
3. From the Formatting Toolbar, click on the Email Link option.
4. A small text entry box will appear below the toolbar. Type the email address you would like users to send their emails to into the small box. For example, Andy.Todd@ed.ac.uk.
5. Click on the blue tick to set the text link.

The word here has now been linked to the email address you entered for the link. The linked word is underlined and highlighted in blue to show that it has been set to be a text-based link.

6. Click Save, followed by preview this asset.
7. With the Webfolio window in preview mode, click on the word here to confirm that the email link works correctly.
An Introduction to PebblePad

If your recipient’s computer has MS Outlook installed and set up, a new email will be created automatically with the email address you entered earlier visible in the To... field, as below.

Note: If the user has MS Outlook installed, but not set up, they will be asked to set up this mail client for their computer. Information on how to do this can be found at http://help.outlook.com/en-gb/140/dd253202.aspx.
Saving pages to the Asset Store

PebblePad allows you to save particular pages to the Asset Store. This is useful if you wish to link text to assets or share a specific page with another user.

Task 7.16  Saving the ‘Portfolio’ page to the Asset Store

In this exercise, you are going to save the portfolio page of your Webfolio to the Asset Store. You will then create a link from a Blog entry to take the viewer to this page.

To save your ‘Portfolio page’ to the Asset Store:

1. Open the Portfolio page of the Webfolio.
2. Switch your Webfolio back to edit mode and click on the manage properties option below the banner. This will open the Folio page Properties window.
3. At the bottom of the Folio page Properties window, check the Save to asset store option.
4. Click Save in the Webfolio and close both the Webfolio and Folio page Properties windows.
5. From the menu bar, click on View, followed by Assets to open the Asset Store.

Your saved Folio page will now appear in the Asset store with the Folio page icon next to it.
An Introduction to PebblePad

You will create a text-based link to this asset from within your Blog later in this workbook.

8. Formatting and customising your Webfolio

Now that you have added the content and a basic structure to your Webfolio, it is time to begin editing it to make it more visually appealing. Formatting text, adding background images and banners can help to enhance its appearance.

In this section of this workbook, you will format text (bold, italics, colour, and format style) and learn how to customise the appearance of your assets (banners, backgrounds and content).

Formatting text in your Webfolio

When working with text, you can use subtle formatting changes to highlight and emphasise certain words.

In the following task, you will perform edits (bold, italics, colour and format style) to the text within your about me page.

Task 8.1 Adding bold formatting to text

You can use bold text formatting to add emphasis to specific words or sections of text.

**To add bold formatting to text on the ‘About me’ page:**

1. Open your Webfolio window in edit mode.
2. From the navigation menu on the left-hand side of the window, click on about me.
3. Within your text, highlight the word navigation to display the Formatting Toolbar.
4. From the toolbar, click on the Bold option \[B\] to add bold formatting to the selected text.
5. Now do the same to the text examples of my work, read my blog entries and make contact with me.

Once you have added bold formatting, your about me page should begin to take shape.
Task 8.2  Adding italics to text

You can use italics to add emphasis to specific words or sections of text within your portfolio.

To italicise text on the ‘About me’ page:

1. Within your text, highlight the words Nice Locations to display the Formatting Toolbar.

2. From the toolbar, click on the italic option \[i\] to italicise the selected text.

3. Now do the same to the text sporting events, music concerts and wildlife.

Once you have added bold and italic formatting to the selected text, your about me page should look similar to the screenshot below.

![Screenshot of aポートfolio page with italics applied to text]

Task 8.3  Changing the colour of text

The process of changing the colour of text in PebblePad is very similar to making text bold or adding italics.

To change the colour of text on the ‘About me’ page:

1. Within your text, highlight the first paragraph of text (beginning ‘My name is...’) to display the Formatting Toolbar.

2. From the toolbar, click on the Colour Options option \[\text{}\] to display the colour palette.

3. From the colour palette, select a colour for your selected text.

Your highlighted text will now change to the colour you selected.
An Introduction to PebblePad

If you wish to change the colour again, make another text selection and choose a different colour from the palette.

4. Highlight some more text on the about me page of your Webfolio and change its colour.

As you can see from the screenshot below, additional colour formatting has been applied to the bold text (black colouring), and to the last two lines (blue colouring).

Task 8.4 Formatting the text style

The final formatting option you are going use is the format style option. This option includes heading, sub-heading, alignment, text size and sub/superscript.

To format the style of the text on the ‘About me’ page:

1. Highlight the text Hi and welcome to my page... to display the Formatting Toolbar.

2. From the toolbar, click on the Format Style option [ ] . The formatting style options will appear below the toolbar.
An Introduction to PebblePad

3. Click on Heading 1 to apply this style to your highlighted text.

4. Highlight the same piece of text again, and use the Increase Text Size option twice to make your selected text bigger.

Once you have applied the formatting, the text on your about me page should have been updated.

![Highlighted text example]

**Task 8.5  Removing text formatting**

If you wish to remove any formatting from your text, you can do so by using the Remove All Formatting option. You will now use this option to remove the colour formatting you applied to the first paragraph of text.

**To remove text formatting from the ‘About me’ page:**

1. Highlight the paragraph of blue text beginning with ‘My name is…’ on the about me page.

2. From the Formatting Toolbar, click on the Remove All Formatting option.

All formatting previously applied to the selected text will now be removed, as shown below.

![Comparison of text with and without formatting]
An Introduction to PebblePad

Task 8.6 Formatting the remainder of your Webfolio

Now that you have applied formatting to the about me page, it is time to format the remaining text within some of the other pages of the Webfolio.

Work your way through the remaining pages of your Webfolio in edit mode, applying formatting to any sections of text.

Below are some examples of how the text can be formatted on the other pages of your Webfolio.

Example of formatting applied to the ‘Portfolio’ page

The text next to each of the images has been increased four times using the Increase Text Size option. Bold formatting has also been applied to each line of text.

Example of formatting applied to the ‘Contact’ page

The text for each section has been increased four times using the Increase Text Size option. Bold formatting has been applied to the line of text below each method of contact. The text for each method of contact has also had the colour changed. Finally, the Italic option has been used to italicise the contact information (address/phone number) within two of the sections (Post and Phone).
Customising the appearance of your Webfolio

Now that you have formatted the text, you are going to customise the appearance of your Webfolio. In this section of the workbook, you will learn how to create your own banner for the top of your assets, change the background image for each asset, and alter the content (text and navigation menu) style and colour.

Task 8.7  Browsing and selecting asset banners

At the top of each asset, you will see a banner. Pebble+ comes with a range of default banners, allowing you to change the look and feel of any asset, workbook or template. You can also create your own banner using the Customise Banner Tool.

Within any open asset, you can view default and existing banners, allowing you to preview how a banner will look on a specific asset, before you apply it.

To browse and select a banner for your asset:

1. Open your Blog from the Asset Store (View > Assets).

2. Click on the edit this asset option to put the Blog into edit mode.

3. Hover the cursor over the banner at the top of the asset, and click and drag to the left or right to cycle through the available banners.

You can also use this method to select a user-created banner, provided you have created and saved one prior to browsing through them.

4. Click on the preview this asset option, followed by the full screen preview option to see how the asset will look with the selected banner.

It is recommended that you use the full screen preview option to view your banner before saving your asset. Previewing a banner in full screen will provide a background for the asset, and will allow you to see how your asset will look.

The images below show how the selected banner appears at the top of the Blog in Pebble+ (left), and how the Blog appears when previewed in a web browser in full screen mode (right).

5. Close the Blog, and when the save this blog dialog box appears, click the [close] button.
An Introduction to PebblePad

Task 8.8  Creating a custom banner

As well as the default Pebble+ banners, you can also create your own theme using the Customise Banner Tool. This allows you to not only create a custom banner using your own image, but also change the background image and content style/colour.

In this exercise, you are going to create your own banner for your Webfolio.

To customise the banner:

1. From the menu bar, select Tools & Resources, followed by Customise Banners to open the Create Custom Banner Tool.

2. Under the Banner tab, locate the Your theme name section, and type Photography Webfolio into the box.

3. Click on the [Select a Banner Image] button to open the Asset Store.

4. From the Asset Store, click [Upload] to upload an additional image file from the Pebble+ Workbook Files folder.

5. In the Upload File window, under Title type Webfolio Banner Image.

6. Under Description, type An image of a camera for the webfolio banner.

7. Click the [Browse] button and open the Pebble+ Workbook Files folder.

8. Open the Misc Images folder, select the Camera2 file and click the [Open] button.

9. Confirm that you are entitled to use this image and click the [Save & Upload] button.
Your image will be processed as before and will appear in the Upload File window.

10. Once your image has been uploaded, **Close** the **Upload File** window.

11. Within the **Create Custom Banner Tool**, click [Select a Banner Image] again.

12. This time, select the asset titled **Webfolio Banner Image**, and click [Confirm].

Once you have confirmed you wish to use this image, it will appear on-screen, ready to be sized and positioned for use as an asset banner.

As you can see from the image below, the Create Custom Banner window displays two different sections. The section on the left allows you to select which part of your uploaded image you wish to use for your banner. The section on the right shows a preview of how your selection will appear.

13. Check the **Show Design Banner** option below the text **Drag the image around to create your banner**.

14. Within the left section where your image appears, click inside the **Drag to resize** box and move the cursor vertically to a section of the image you wish to use as your banner. Have a look at the right hand section as you do so to preview how your selection will look.
An Introduction to PebblePad

15. Check the *Show Form Banner* option below the text *Drag the image around to create your banner.*

This time you will be able to move the box within the left section horizontally. This means you can select another part of your image to use as the banner. The right-hand section will still function as a preview window for your banner.

16. You can use the same click and drag method for the *Drag Horizontal* box as before, however, this time move the cursor horizontally.

17. Position the box in a suitable position to display the section of the image you wish to use as your banner.

18. Click the *Save* button within the *Create Custom Banner Tool.*

Once you are satisfied with your banner position, you can move onto Task 8.9.
Task 8.9   Creating a custom background

The Customise Banner Tool allows you to choose either a background style or background image for your assets. You can use the Background Style option to select a default background style or colour for the theme. Again, the right-hand side section is used to preview any changes or selections made.

Although useful, the default styles available might not be suitable for your assets. Instead, in the following exercise you are going to use your own image for your asset backgrounds.

To create a custom background using your own image:

1. From within the Create Custom Banner Tool, click on the Background tab.
2. Check the Background Image option, located below the Content tab.
3. Click on the [Select a Background Image] button to open the Asset Store.
4. Click on the [Upload] button.
5. In the File Upload window, enter Road Background Image as the Title and Image of a road for the background as the description.
6. Click [Browse] and open the Pebble* Workbook Files folder.
7. Open the Locations folder, select the file named Road and click the [Open] button.
8. Once the file has been uploaded, select it from Asset Store, and click [Confirm].

The uploaded image will now appear and can be previewed within the Create Custom Banner Tool.

9. From the options above the left-hand side section, check the Stretch option. This will stretch the image to fit the entire background.
An Introduction to PebblePad

Task 8.10 Customising themes

Now that you have customised your banner and background image, the final task is to customise the content style. You can select a colour for your title text, navigation text, header divider and content area colour for the theme.

To change the content style of your theme:

1. In the Create Customer Banner Tool, click on the Content tab.

2. Select a content area colour from the list of defaults. As before, you can check how the selected content will appear using the preview section on the right-hand side.

3. Click inside the box next to Title text to display the colour chart for the title text colour.

4. From the colour chart, select a colour for your title text.
Once you have selected a colour from the chart, it can be previewed in the right-hand side section.

5. Check the **Header Divider** option, which will then display the **Divider colour** option.

6. Click on the small box next to **Divider colour** to open the **colour chart**. From the chart, select the colour **yellow**.

A yellow divider will now appear on the image in the preview box.

7. Click **Save** followed by **Close**.
An Introduction to PebblePad

Task 8.11 Selecting and previewing banners

Now that you have created and saved your banner, it is time to select it for use on your Webfolio. In this exercise, you will also preview your Webfolio in a web browser to see how your new banner and theme will look for viewers.

To add and preview your customised banner on your Webfolio:

1. Open the Asset Store (View > Assets), select your Photography Webfolio and click on the [Edit] button.

2. Click and drag the top banner to the left or right until you see the banner you created.

3. Click Save 📜, followed by preview this asset 📝.

4. Now click on the full screen preview button 📸 to view your Webfolio in a web browser.
Task 8.12  Editing your customised theme

Having viewed your Webfolio in a web browser, you may wish to make some changes to your banner or theme. For example, perhaps the yellow divider doesn’t really work with the colour you have chosen for the text. Existing themes can be edited, meaning you don’t have to create a new one every time you wish to make changes.

To edit your custom theme:

1. Click on the edit mode button on your Webfolio to enter edit mode.
2. Hover the mouse over the banner to display the New and Edit options inside the banner, as shown below.

3. Click on the Edit button to open the Customise Banner Tool.
4. Change the colour of the Header Divider and Title to any other suitable colour.
5. Click Save and Close.

You can now view your Webfolio in full screen preview mode to see how your alterations look.
An Introduction to PebblePad

9. The View menu

The View menu contains several key components of the Pebble+ system, each of which is outlined briefly in the following table.

<table>
<thead>
<tr>
<th>Option</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| Asset Store    | ![Assets](image) | The Asset Store is your own personal store, which contains any content you have created, uploaded or had shared with you in Pebble+.
| Contacts       | ![Contacts](image) | Your contacts are people you can share content with. The Contact Manager allows you to add new contacts and create new groups, as well as manage existing contacts and groups.
| My Details     | ![My details](image) | You can use the My details option to add your own personal details to Pebble+. You can include a profile image, name, address, contact info, each of which can be used to create a calling card CV item.
| Messages       | ![Messages](image) | The Message Centre is used to display any notifications from Pebble+ and ATLAS regarding shared content, comments, reminders, feedback, resources and receipts.
| Tags           | ![Tags](image) | Tags can be used in Pebble+ to organise assets. The Tag Manager allows you to add and manage new and existing tags. |

In this section of the workbook, you are going to learn how to use and manage the Asset Store, Contacts and Tags.

**Assets and the Asset Store**

As previously stated, content you create, save and share with others in Pebble+ is known as an asset. All saved or shared assets are held in the Asset Store.

The Asset Store is a menu from which you can open, edit, organise and share existing assets with others. The contents of the Asset Store appear in a scrollable list, and can be filtered by category or status when searching.

As you have already been using the Asset Store briefly during exercises in workbook, you will be familiar with its appearance.
An Introduction to PebblePad

Task 9.1  Sorting your assets in the Asset Store

All assets contained within your Asset Store will be stored in one of three locations: the By Me, the For Me or the With Me tabs.

<table>
<thead>
<tr>
<th>Option</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>By Me</td>
<td><img src="image" alt="By Me" /></td>
<td>Every asset you have created or uploaded to the system will be stored here.</td>
</tr>
<tr>
<td>For Me</td>
<td><img src="image" alt="For Me" /></td>
<td>Assets that other Pebble+ users share with you will be stored here.</td>
</tr>
<tr>
<td>With Me</td>
<td><img src="image" alt="With Me" /></td>
<td>Any assets that you have collaborative permissions on will be stored here.</td>
</tr>
</tbody>
</table>

Within the Asset Store, assets can be sorted in a variety of ways, including category (Post, Record, Design etc.), title (alphabetical ascending/descending), date created and by tag.

To arrange assets using headings:

1. Open your Asset Store (View > Assets).
2. Click on the [By Me] button to display assets created or uploaded by you.

When the Asset Store opens, your assets will be ordered by date created (newest first). Even if you change the order of your assets and close the Asset Store, the next time it is opened, the assets will revert back to the default ordering system.

3. Single click on the Title heading above your assets.
An Introduction to PebblePad

A small down pointing arrow appears at the end of the Title bar. Your assets will now be arranged alphabetically by their title in ascending order.

You can click on this heading again to display your assets in descending alphabetical order. Additionally, you can use the *Created* and *Tags* headings to arrange your assets in a different order.

**Asset statuses in the Asset Store**

Assets contained within the Asset Store can have one of three statuses; Current, Hidden or Deleted status.

<table>
<thead>
<tr>
<th>Option</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>[Current]</td>
<td>Any asset you create will automatically have this status by default when stored in the Asset Store.</td>
</tr>
<tr>
<td>Hidden</td>
<td>[Hidden]</td>
<td>Active assets which are not displayed in the Asset Store have this status. This is a useful status if you wish to hide old assets or assets which are not currently being used, for use later.</td>
</tr>
<tr>
<td>Deleted</td>
<td>[Deleted]</td>
<td>Any assets which have been deleted will have this status. Up to 50 assets can have this status whilst they are waiting to be permanently removed from Pebble*</td>
</tr>
</tbody>
</table>

At the bottom of the Asset Store are several options which allow you to manage your assets. Each of these options will remain greyed out until you select one or more assets.
An Introduction to PebblePad

The table below contains a brief description of the function each option performs.

<table>
<thead>
<tr>
<th>Option</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>View</td>
<td>Selected assets will open in preview mode. Can be switched to edit mode once opened.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edit</td>
<td>Selected assets will open in edit mode. Can be switched to preview mode once opened.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
<td>Selected assets will be deleted and moved to the deleted items area. Up to 50 deleted items can be kept here, and restored if necessary.</td>
</tr>
<tr>
<td>Share</td>
<td>Share</td>
<td>Allows you to share selected assets with your contacts.</td>
</tr>
<tr>
<td>Submit</td>
<td>Submit</td>
<td>Selected assets can be submitted to an ATLAS Workspace for review by tutor or peers.</td>
</tr>
<tr>
<td>Publish</td>
<td>Publish</td>
<td>Selected assets/content are sent to an external service or are made available for viewing on the internet.</td>
</tr>
<tr>
<td>Add To</td>
<td>Add To</td>
<td>Selected assets can be added to an existing Activity Log or Blog.</td>
</tr>
<tr>
<td>Organise</td>
<td>Organise</td>
<td>Selected assets can be tagged, moved, copied or restored (if deleted).</td>
</tr>
</tbody>
</table>

Task 9.2  Changing the status of an asset

You are now going to make use of the Organise option in the Asset Store. You will use this to move some of your unused images from the Current to Hidden asset status folder.

To move assets using the Organise button:

1. Open the Asset Store to display your assets.
2. Check that the Asset Status is set to Current on the left-hand side of the window.
3. Under Category, select Media from the list. This will display all Current assets which fall under the media category.
An Introduction to PebblePad

4. Use the scroll bar on the right-hand side of the Asset Store to scroll down to the images Rome 1-5.

5. Click on the image Rome 5 to select it.

6. Hold down the Shift key and click on Rome 1.

The Shift key allows you to select a group of assets, as shown below.

7. Click on the [Organise] button.

8. From the pop-up Organise options, select Move.

You will now be asked to choose a location to move the selected assets to.

9. Click on the [Hidden] button.

Once this dialog box closes, you will be taken back to the Asset Store. If you can still see the files, click the Refresh button to refresh the window. The selected files will then no longer be visible in the Current status folder, as shown below.

10. Under Asset Status on the left-hand side of the Asset Store, click on Hidden.
The image assets you moved from the Current folder will now be visible in the Hidden folder, as shown below.

The Organise option can be used to move assets to and from any of the Current, Hidden and Deleted folders.

**Task 9.3 Searching the Asset Store**

In addition to the sorting options already discussed, you can also use the Search tool to search for specific assets. This tool searches the currently selected category, allowing you to look for a particular asset type, for example, documents or media.

**To use the Search option within the Asset Store:**

1. From the **Category** section of the **Asset Store**, select **Media** to display only media related assets.

2. Click inside the **Search** box at the top of the window, and type **Surf**.

The Asset Store will now filter your media assets to display only those containing the word surf in their title.

You can clear your search entry by clicking the small cross inside the Search tool.
An Introduction to PebblePad

Contacts

In order for you to be able to share an asset or template using Pebble+, the recipient must first be added to your Contact Manager. You can add contacts by searching within your organisation, or by adding an existing contact by entering their name and email address. You can also use the Contact Manager to group your contacts, especially useful for sending a single asset to multiple users.

The Contact Manager

The Contact Manager is the main hub where you can add new and view existing contacts. To open the Contact Manager, select Contacts from the View menu. The first time you open the Contact Manager (or until you add a contact), it will look like the below screenshot.

![Contact Manager Screenshot](image)

Some of the options at the bottom of the manager are greyed out (Group Contacts and Delete). These options will remain unavailable until you add a new contact to the list. Once you have done so, these options will become accessible.
An Introduction to PebblePad

Task 9.4 Adding a new contact from your organisation

You can add a new contact from your organisation using the New Contact button. You are able to search for this contact using either their user name or email address as the primary search criteria, or a given or family name for the secondary criteria.

**To add a new contact to the Contact Manager from your organisation:**

1. Open the Contact Manager (View > Contacts).

2. From the Contact Manager, click on the [New Contact] button.

An Add New Contact section will now open up in the Contact Manager, as highlighted below.

3. Use the Primary Criteria area of the Add New Contact section to search for a contact by username or email address. In the text entry box below Username/Email, enter the username/email address of the individual you wish to search for.

4. Click on the [Search] button.
An Introduction to PebblePad

Pebble+ will now perform a search for any contacts from within your organisation with a matching username. As you can see from the screenshot below, a match has been found for this user.

5. Click on the contact to select them.

6. Click the [Add] button.

7. To display this contact in the Contact Manager, click the Refresh button to update the contacts.

Your newly added contact will now be visible in the window, as highlighted below. The name, username and email address fields will automatically be updated based on the information Pebble+ can access for that particular contact.

You can use this method to add other members from within your organisation to your Contact Manager.
Task 9.5 Adding an external contact

As well as being able to add a contact from your organisation, you can also add an external contact. You will be asked to enter a name and email address for this contact, before they are then added to your contacts.

To add an external contact to the Contact Manager:

1. Open the Contact Manager (View > Contacts).
2. From within the Contact Manager, click on the [New External] button.

An Add External Contact section will now open up within the Contact Manager, as highlighted below.

3. Under Name, enter the name of your external contact, for example, Garry Briggs.
4. Under Email, enter the email address.
5. Under Confirm Email, re-enter the same email address.

Your completed form should look similar to the one below.

6. Click the [Save] button.

Your newly added contact will now be visible in the Contact Manager.
Managing your contacts

In a similar way to assets in the Asset Store, contacts within the Contact Manager can be organised and displayed in various ways. In this section of the workbook, you will look at how to group, organise and delete your contacts within the Contact Manager.

Task 9.6  Grouping your contacts

The Contact Manager allows you to view your contacts individually or as groups using the People or Groups buttons. You will not see any groups in the Contact Manager until you have created a new group and added contacts to it. Once you have created a group, you can then add individual contacts.

To create a new group and add contacts:

1. Open the Contact Manager (View > Contacts).
2. From the options at the bottom of the window, click on the [New Group] button.

The Add Group section will now open up in the Contact Manager.

3. Under Group Name, type Pebble+ Project.
4. Under Group Description, type This group contains contacts involved in the Pebble+ project.
5. From the contact list, click and drag a contact into the Members section. You can also select and drag multiple contacts by holding the Ctrl key as you select the contacts.
An Introduction to PebblePad

Your selected contacts will now appear in the Members section of the Add Group panel, as shown below.

You can remove any contacts from the Members group using the Remove from group button.

6. Now click the [Save] button.

The Add Group section will now close.

7. Click on the [Groups] button at the top left-hand side of the Contact Manager.

You will now see your newly created group within the Contact Manager. The name and description you entered when creating the group will also be displayed.
An Introduction to PebblePad

Task 9.7 Organising your contacts

By default, every time you open the Contact Manager, all individual contacts will be displayed together, irrespective of how they had previously been viewed.

The People and Groups options at the top left of the Contact Manager allow you to choose whether to display individual contacts or groups. If you have not created any groups and select the Groups option, no contacts will be displayed.

Below the People and Group buttons are options to filter contacts by letter, number or all (left-hand side of window). Clicking on a letter will display any contacts with a forename beginning with that letter. The All button can be used to display all of your contacts simultaneously.

You can also use the Name, Username and Email Address headings to organise your contacts within the Contact Manager. This works in the same way as organising your assets within the Asset Store.

You can view more information on individual contacts or groups using the Pop out option. This option is visible next to each contact and group, and will open up a new information window when clicked. If you click on the Pop out option for a contact belonging to a group, this information will be visible in the Information window, as shown below.
Task 9.8  Deleting contacts or groups

Single contacts or groups can be deleted from the Contact Manager using the *Delete* option next to each contact.

This method is useful if you wish to remove individual contacts from your contact list. You can also delete multiple contacts simultaneously or delete an entire group.

*To delete multiple contacts:*

1. Select a single contact from the list in the *Contact Manager*.
2. Hold the Ctrl key and select another two contacts from the list.
3. Once they are all highlighted, click on the [Delete] button.

You will be asked to confirm whether or not you wish to delete three contacts.

4. Click [Yes] to confirm.

The three contacts you selected will no longer be visible in your Contact Manager. You can also use this method to delete single or multiple groups from the Contact Manager.
An Introduction to PebblePad

Tags
Tags can be used to help make searching and organising assets easier within the Asset Store. If you have a specific group of assets which you are going to use for a project, you can give them all identical tags. When you search for that tag in the Asset Store, only assets which have been tagged with that tag will be displayed.

Pebble+ allows you to add multiple tags to one single asset, useful if one particular asset is to be used for multiple projects.

In the following exercises, you are going to add tags to new and existing assets within the Asset Store. You are also going to add to and edit tags contained within the Tag Manager.

Task 9.9 Adding tags to single and multiple assets
In the following exercises, you will learn how to add a tag to both single and multiple assets within the Asset Store.

To add a tag to a single asset or file:

1. Open the Asset Store (View > Assets).
2. From the Category section, select Media to display only media related assets.
3. Double click on the asset titled Webfolio Banner Image.
4. Click on the edit this asset option to put the asset into Edit Mode.
5. Click on the view or add tags option, located at the bottom of the Webfolio Banner Image window.

The Tag window for your selected asset will now open alongside the Upload File window.

6. In the Tag window, click inside the text entry box under Add comma or ‘enter’ to create tags, and type Banner Image.
7. Press the Return key (Enter) to add this tag.
An Introduction to PebblePad

The text you entered will now change to a small tag icon with the text inside. As you add each tag, your asset will be saved and you will be informed that a tag has been added to this asset. Multiple tags can be entered by separating each entry with a comma.

8. Add two more tags named Camera and Webfolio.

You can also use the see all tags button to view any existing tags you have created and added to any asset.

9. Close the Upload File and Tag windows once you have added and saved the tags.

The tags you entered for this asset will now be displayed under the Tags heading in the Asset Store. If your tags don’t appear next to the image asset, click the Refresh button.

You can also add tags to multiple assets simultaneously using the [Organise] button at the bottom of the Asset Store. This is a quicker alternative to adding tags to one asset at a time.

In the following exercise, you will add a tag to all of your surfing related image assets simultaneously.

To add a tag to multiple assets simultaneously:

1. Open the Asset Store (View > Assets).
2. From the Category section, select Media to display only media related assets.
3. Click on the asset titled Surf 1 and whilst holding the Shift key, click on the asset titled Surf 5. This will select all of the surfing images within the Asset Store.
4. Click on the [Organise] button and from the pop-up menu, select Tag.
An Introduction to PebblePad

As before, the Tag window will appear on-screen for you to enter your tags into.

5. Click inside the box and type **Surfing Image**, followed by the pressing the Return key.

Your tag will now be applied to the multiple surfing assets within the Asset Store.

6. Close the Asset Store and **Tag Manager**.

The Tag Manager

The Tag Manager can be used to add new, rename and delete existing tags.

It will display any tags which you have created, irrespective of which asset they have or have not been applied to.

**Task 9.10 Add new tags using the Tag Manager**

In this exercise, you are now going to add a new tag directly to the Tag Manager.

*To add a new tag to the Tag Manager:*

1. Select **View** from the menu bar, followed by **Tags** to open the **Tag Manager**.

2. In the text entry box under **Add comma or ‘enter’ to create tags**, type **New Tag** and press the Return key.

Your newly created tag will now be added to the **All tags** section of the Tag Manager.
Task 9.11    Renaming existing tags

The Tag Manager can also be used to rename existing tags. You will now rename the new tag you added to the Tag Manager in the previous exercise.

To rename an existing tag:

1. Single click on the New Tag tag, displayed within the All tags section of the Tag Manager.

   The text from the selected tag will now appear in the Manage tags section of the tag manager, as highlighted below.

2. Click inside the Manage tags text box and change the text New Tag to New Tag – Images only.

3. Now click on the [Rename] button.

   The name of your selected tag will change from New Tag to New Tag – Images only.

   ![Image of Tag Manager with the new tag highlighted]

   ![Image of Manage tags section with the new tag highlighted]

   ![Image of Asset Store with the new tag highlighted]

   Note: Any changes made to an existing tag within the Tag Manager will also be applied to tags already assigned to assets within the Asset Store.
An Introduction to PebblePad

Task 9.12  Deleting tags

Tags can be deleted from any asset directly or from within the Tag Manager. Deleting a tag directly from the asset means that only this asset will lose the tag. Deleting a tag from the Tag Manager will remove it completely from any assets it was applied to.

In the following exercises, you are going to remove the surfing image tag directly from both an individual asset and the Tag Manager.

To remove a tag from an asset:

1. Open the Asset Store (View > Assets).
2. From the Category section of the Asset Store, select Media.
3. Click on the asset titled Surf 5.
4. Click on the [Organise] button and from the pop-up menu, select Tag.
5. When the Tag window opens, click on the Delete option within the tag Surfing Image.
6. Close the Tag window.

The Asset Store will automatically update to reflect this change. The surf 5 asset will no longer have the Surfing Image tag attached to it.

To delete a tag from the Tag Manager:

1. Open the Tag Manager (View > Tags).
2. Within the All tags section, click on the Delete option on the Surfing Image tag.

You will be asked if you are sure you wish to delete this specific tag from the Tag Manager.

3. Click the [Yes] button to confirm.

As this tag has been deleted from within the Tag Manager, this tag will now be removed from any asset it had previously been applied to.
Hours, Points and Activity Logs

PebblePad can be used to log how much effort you have given to a particular task by logging hours or points against a specific asset. You can log hours or points against any new or existing asset, before creating and updating an Activity Log to chart progress. This can be particularly useful if, for example, you are working on a group project and wish to demonstrate how much time and effort you have contributed to the project.

If for example, you have attended several meetings and wish to detail how much time has been spent attending meetings, you can use an Activity Log to track this.

In this section of the workbook, you will assign time and points to an existing asset, before adding this asset to a newly created Activity Log.

Hours and points

Hours and points can be assigned to any asset you have created or have had shared with you. If you then add this asset to the Activity Log, a running total of time or points will be created.

Task 9.13 Logging hours or points against an asset

The process of adding hours or points to an asset is the same whether the asset is new or an existing one from the Asset Store.

In the following task, you will log time and points against the journal entry you created for your Webfolio.

To log hours against an existing asset:

1. Open the Asset Store (View > Assets).
2. Under Category, select Records.
3. In the Search box, type Attended. This should filter your assets to show only your Journal Entry asset.
4. Click on the asset to select it, and click the [Edit] button.
5. At the bottom right-hand side of the asset, click on the log hours or points option.

The Activity Logger window will now open alongside your Journal Entry window.

6. In the box next to hrs, type 3, and in the box next to mins, type 30.
7. Now click the [Save] button to log your entry.

The time you have entered for this asset will now be saved. If you open the Activity Logger for this particular asset again, the time you entered and saved will be visible.
An Introduction to PebblePad

Activity Logs

Having logged hours against the Journal Entry, you need to create an Activity Log to keep a running total of the hours assigned to this asset, or any other assets. This log can be updated and shared with others at any time.

Task 9.14 Creating an Activity Log

You are now going to create an Activity Log, to which you will add a target amount of hours to. Your Journal Entry asset will then be added to this log.

To create an Activity Log:

1. Click on Design New from the menu bar, followed by Activity Log.

This will open the Activity Log and the Activity Log Properties windows.

2. Under Activity Log Title in the Activity Log Properties window, type Photography Course Activity Log.

3. Under Description, type This activity log will be used to log how much time I have spent attending photography courses.

4. Tick the add end date checkbox. This will now create a field for you to enter an end date for your Activity Log.

5. Click on the calendar icons and from the pop-up calendars, select a ‘from’ and ‘to’ date for each. This is the period of time that activities can be logged using this Activity Log.

6. In the text entry box next to Target Hours, type 30.
Your completed Activity Log Properties window should look similar to the screenshot below.

7. **Close** the Activity Log Properties window.

Your Activity Log will now have been updated with the settings you entered into the Activity Log Properties window.

8. Now click **Save** on the Activity Log window.

9. Leave the Activity Log open on-screen.

**Note:** Clicking the Refresh icon within the Activity Log will reset the Activity Log Title and Short Description back to their default (empty).

Now that you have created your Activity Log, it is time to add your Journal Entry asset to it.
An Introduction to PebblePad

Task 9.15  Adding an asset to your Activity Log

You can either add a new activity or existing asset to your Activity Log. Providing your added asset has hours or points logged against it, the Activity Log will be updated to display this.

If you decide to use the Add New button, a new activity will be created for you to complete and the Activity Log will be updated based on the hours or points you log against it.

For this task, you are going to add your Journal Entry asset to your Activity Log using the Add Existing button.

To add an existing asset to an Activity Log using the Add Existing button:

1. Within the Activity Log, click on the [Add Existing] button to open the Asset Store.
2. Scroll down and single click on your journal entry titled Attended ‘Photography…’ to highlight it.
3. Click on the [Confirm] button.

The Activity Log should automatically update to display your newly added Journal Entry. If it doesn’t automatically update, click the Refresh button to refresh the window.

As you can see, the activities recorded on this activity log currently amount to section has updated to display 3 hours and 30 minutes. This is the amount of time logged against the Journal Entry you added.

The Journal Entry you added will also be displayed within the Activity Log. You can edit or remove any assets you add to the Activity Log using the edit entry and remove entry options.
10. The Settings menu

The Settings menu contains two options; Notifications and Link to Google Drive.

Notifications

By default, Pebble+ has been set up to provide you with as much help and advice as possible. Pebble+ and ATLAS will provide you with messages and notifications in relation to shared content, comments, receipts, feedback, reminders and resources.

Using the Notifications setting, you can set your own personal preferences for how and when to receive messages and notifications.

For each type of notification in Pebble+ or ATLAS, you can choose three different options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digest</td>
<td>Notifications remain in chronological order and are emailed in a single email on a day and time you decide.</td>
</tr>
<tr>
<td>Email</td>
<td>Notifications are emailed every time a new message is generated.</td>
</tr>
<tr>
<td>Feed</td>
<td>Notifications will appear in your message centre in chronological order.</td>
</tr>
</tbody>
</table>

Task 10.1 Setting up your Notifications

In this exercise, you are going to change some of the default notification settings within Pebble+ to suit your personal preference.

To customise your Notifications:

1. From the menu bar, select Settings, followed by Notifications.

The Notifications window will now open in a new web browser window.

Some of the notification methods are checked by default. These are shown by the checked boxes.
An Introduction to PebblePad

2. Under **Digest**, check the **Grades** and **Feedback** boxes.

3. Under **Email**, check the **Comments** box and un-check the **Grades** box.

4. From the drop-down box next to **Send me a digest email on**, select **Monday**.

5. From the drop-down box next to **at this time**, select **10:00**.

6. Click on the [Save] button to save your new settings.

You will now receive the selected notifications via email every Monday at 10am.
Sharing, submitting and publishing assets

Pebble* allows you to share your assets with both new and existing contacts, submit them to ATLAS (institutional space set up by teachers for submissions), and publish them online.

In this section of the workbook, you are going to look at the various methods available for sharing and publishing your assets and Webfolio.

Sharing assets with others

You can share single or multiple assets with users from within your organisation and with external users. You can set and edit specific sharing permissions for each asset before or during a share.

Assets (single or multiple) can be shared using the Do More Button or via the Asset Store. The Do More Button is used to share a single asset, and the Asset Store used to share both single and multiple assets.

Task 11.1  Sharing an asset using the Do More Button

In this exercise, you are going to share your surfing image Collection asset with one of your contacts using the Do More Button.

To share an asset using the Do More Button:

1. Open the Asset Store (View > Assets).
2. From the Category section, select Designs.
3. Double click on your Collection asset titled Surfing Photos to open this asset.
4. Click on the Do More Button from the top left-hand corner of the Collection, and select Share from the drop-down list.

The Sharing window will now open for you to choose your share properties.
An Introduction to PebblePad

5. In the To: box, enter one of the contacts you previously added. As you begin to type the contact’s name, their name and email address should appear below, provided they are in your contacts list. If they are not in your contacts list, you will be given the option to search for them or create a new external contact.

6. Click on the contact pop-up to add them as your recipient. Alternatively, you can finish typing their name into the box. This contact will now be added as the recipient, as shown below.

You can add as many contacts as you wish to the To: box. You can also add contacts to the Bcc: box, as you may do with an email. Anyone in the To: box will be visible to all recipients, whereas contacts in the Bcc: box will be hidden when the asset is sent.

7. Under the Permissions section, check the comment box. This will entitle recipients to add comments to your asset. You can also use the Show advanced permissions if you wish to set additional permissions.

8. Under the Permissions apply until section, check the ongoing option.

9. Under the Message to recipients section, type Here is a collection of my surfing photos.

Your Sharing window should appear similar to the one below once you have entered the relevant information and changed the settings.

10. Click on the [Share] button to share this asset with your chosen recipient(s).

You will now be informed that you have shared this asset with a contact(s).
Task 11.2 Sharing multiple assets

To share multiple assets with others, you must use the Asset Store as this is the only method of selecting multiple assets.

To share multiple assets using the Asset Store:

1. Open the Asset Store (View > Assets).
2. From the Category section, select Media.
3. Holding the Ctrl key, select the Golf 1, 3 and 5 assets. The Ctrl key allows you to select more than one item at a time, but will not select all items between two as was the case with the Shift key.

These 3 assets should appear highlighted within your Asset Store, as below.

4. Click on the [Share] button.
5. When the Sharing window appears, type the name of the contact you wish to share these assets with into the To: box. This can be an external contact and does not have to be a contact from your Pebble+ contact list.
6. Under the Permissions section, check the comment, copy and collaborate boxes.
7. Under the Message to recipients section, type Here is a collection of my golfing pictures.
8. Click on the [Share] button to share these assets your chosen recipient(s).

You will now be informed that you have shared multiple assets.
An Introduction to PebblePad

Task 11.3   Editing a share from an asset

Now that you have shared some assets with others, you can edit the permissions you set. For example, you may wish to change the length of time the recipient can access your shared assets, or you may wish to remove the share entirely.

You are now going to edit some of the permissions you set for the single surfing Collection you shared.

To edit the permissions of a shared asset:

1. Open the Asset Store and from under Category, select Designs.
2. Double click on the Surfing Photos Collection asset.
3. Click on the Information about this asset tab, located on the right-hand side of the Collection window.

The info window for your Surfing Photos Collection will open alongside your asset.

The info window provides any information directly relevant to the open asset. Information includes asset title, author(s), dates created and modified, and the name(s) of any people this asset has been shared with.

4. Click on or hover over the information icon within the Shared with section of the info window.

You will now be able to see more detailed information about the sharing properties of this asset. You can see when this asset has been shared until, any permissions and any accompanying message.
5. Click on the **Edit share** icon to open the **Sharing** window.

The **Sharing** window is the same window used to initially set the share options for the asset.

6. Under **Permissions**, un-check **comment**. The recipient will no longer be able to comment on this asset (once updated).

7. Under **Permissions apply until**, un-check **on-going** and select **25 Dec 2013** as the date.

Your updated **Sharing** window should look similar to the below screenshot.

8. Now click on the **[Update Share]** button.

9. You will be informed that your shared asset has been updated.

As the **notify contacts of changes** option is checked by default, recipients will be notified of any changes via email.
An Introduction to PebblePad

Task 11.4 Removing a share from an asset

The process of removing a share from an asset is very similar to the process of editing a share.

You are now going to remove the share from the surfing Collection asset you have just been working with.

To remove a share from an asset:

1. Click on the Information about this asset tab to the right-hand side of the Surfing Photos Collection window.

2. Click on the Edit share icon to open the Sharing window.

3. Click on the [Unshare] button at the bottom of the Sharing window.

A short warning message will appear on-screen to remind you that the current recipients of the assets will lose access to it.

4. Click the [Yes] button to confirm you wish to remove the share from this asset.

5. Click Close on the info window.

6. On the Collection window, click on the information about this asset to display the info window once more.

The Shared with section should no longer be visible.
Submitting your Webfolio

ATLAS is the institutional space containing Workspaces usually created by tutors or staff to manage teaching activities and assessments. Work created and contained within Pebble+ can be submitted to an ATLAS Workspace for feedback, assessments, reviews or moderation.

You can submit any asset from your Asset Store (subject to assignment preferences) in Pebble+ to ATLAS. To do so, you must have been linked to a Workspace in ATLAS by the creator of the Workspace (usually a tutor or staff member).

Task 11.5 Submitting your Webfolio to ATLAS

You are now going to submit your finished Webfolio asset to an ATLAS Workspace.

Similarly to sharing an asset with a contact, you can either use the Do More Button or the options within the Asset Store to submit an asset to ATLAS.

For this exercise, you are going to use the Do More Button as you are only submitting one single asset.

**Note:** You can only complete this exercise if you have been added to the ATLAS Workspace. Please contact is.skills@ed.ac.uk if you would like to be added to this test photography Workspace.

To submit your Webfolio using the Do More Button:

1. Open the Asset Store (View > Asset store).
2. From the Category section, select Designs.
3. Double click on your Photography Webfolio to open it.
4. Click on the Do More Button , and from the drop-down menu, select Submit.

The Workspace Manager window will now open alongside your Webfolio and will display any Workspaces you have been added to.
An Introduction to PebblePad

5. In the **Workspace Manager** window, click on the **Photography Webfolio Submission** Workspace, and click [Submit].

You will then be asked to agree to a short statement regarding how your submitted asset will and can be viewed by others.

6. Once you have read the information, click [Agree] to continue with the submission.

At this point, you will be informed that your asset has been submitted to the ATLAS Workspace.

You will now receive an email to confirm the submission of your asset. If there are any problems with the submission you will receive a message in Pebble+ and an email informing you of the issue and the status or the submission.

**Note:** You will only see a Workspace within the Workspace Manager if you have been added to one on ATLAS. If you cannot see a Workspace, you will be unable to share content to ATLAS.
Publishing your Webfolio

Assets can also be published to the internet, meaning you can send a URL link to your asset to others. The asset will be hosted by PebblePad, so all you have to do is publish your asset to the web and send the link to whoever you wish to view it. Recipients of the link will then be able to view your asset in their web browser.

Task 11.6  Publishing your Webfolio to the web

In this exercise, you are now going to publish your finished Webfolio to the web so that others can view your online photography portfolio.

To publish your Webfolio to the web:

1. Open the Asset Store (View > Assets)
2. From the Category section, select Designs.
3. Click on your Photography Webfolio to select it.
4. Click on the [Publish] button, and from the pop-up menu, select To Web.

A small Publish To Web dialog box will appear on-screen.

5. Tick the Comment check box to allow viewers to comment on your Webfolio.
6. Click [Publish] to publish your Webfolio and generate a URL.
7. Select the 28th March 2014 next to Expiry Date using the calendar.

The Publish To Web dialog box will now update to display the URL link to your Webfolio, as below.

8. Click [Copy To Clipboard] to copy your link.
An Introduction to PebblePad

9. Open a web browser and paste your copied link into the address bar.

When your Webfolio loads, it should appear similar to that of the one below. You will be able to navigate around the Webfolio and share the link with others to access.

You can now send your Webfolio link to others via email or social network sites.
12. What happens when you leave the University?

If you have been using Pebble and are about to leave the University, you are entitled to a free PebblePad account for 12 months. This account will allow you to take any assets you have created with you to support your personal learning and development when you leave the University.

If you do not apply for this free account before you leave the University, all assets and data will be lost when your University Pebble account is closed.

Creating a free personal account

You can create a free personal PebblePad account from within the Pebble interface. It is important that you create this before you leave the University.

To create a free personal Pebble account:

1. Open the Pebble application.
2. From the menu bar, select Tools & Resources.
3. From the drop-down menu, select Personal Account.

A new web browser page will now open with a PebblePad sign up page. A warning message will appear on-screen to make sure you are nearing the end of your time at the University. This will prevent you from signing up too early and not receiving the best benefit from the account (full 12 months free).

4. Once you have read the message, click Continue to begin creating your free personal account.
An Introduction to PebblePad

Once the warning message has closed, you will see the Collecting details page of the personal account creation form. Some of the fields will have been entered automatically based on the information PebblePad has been able to collect from your current account.

You can edit and update any of these fields as you wish.

5. Under the Personal Email Address: section, enter a personal email address, not your University email address. You must then re-enter this address accurately into the Please confirm email: box.

6. Under the Password: section, enter a password for your account. You must then re-enter this password accurately into the Please confirm password: box.

7. Once you have entered your details, click the [Continue] button.

The next page of the form is the Terms & Conditions page. Here you will be asked to provide a little information into your subject expertise and career destination. PebblePad will use this information to understand what context PebblePad is being used by users.

The Terms & Conditions page of the form can be viewed on the following page.
8. Select a subject that best suits your expertise from the drop-down box under *Please choose your subject expertise*:

9. Select a career that best suits your career destination from the drop-down box under *Please choose your career destination*:

10. Read through the terms and conditions and tick the checkbox to confirm that you agree with them.

11. Click the [Confirm] button to continue to the *Confirmation page*.

The *Confirmation page* will now open. This will display the details you have entered in the previous pages of the form.

12. Once you have checked the details, click the [Confirm] button to create your PebblePad account.

12. What happens when you leave the University?
An Introduction to PebblePad

A new personal account will now be created for you. A link will be displayed on-screen which will take you directly to the login page for your new personal account. You will also receive an email confirming the account set up.

When you login to your new account and open the Asset Store, you will see two tabs. One tab will display assets from your new account, the other will display assets from your own PebblePad account (University).

Newly created assets will appear under the new account tab, whilst existing assets will be stored in the University account tab.

Any assets which have been shared with your University account will not be available in the new personal account unless they are copied over.

What happens after the 12 months are over?

During your time using the free 12 month personal account, you might decide that you wish to continue using Pebble+. If so, you can then sign up to an on-going PebblePad account for a small annual free.

More information on this type of account can be found using the following link:

http://www.pebblepad.co.uk/licences.personal.asp
13. Final note

You have now created, arranged, submitted and published your very own Webfolio using Pebble+. In doing so, you have learnt how to use several of the Pebble+ features, which can be used for most tasks when using Pebble+.

You have learnt how to create, edit and share assets with other users, add and manage contacts, format text, link assets together, customise your Pebble+ interface and customise the appearance of asset banners. You have also learnt how to use text-based links, submit content to ATLAS Workspaces and publish content to the web.

With the knowledge you have gained from this workbook, you will be able to use Pebble+ competently and comfortably to create and share a variety of content with others.

Additional University of Edinburgh Pebble+ support items for staff members can also be found using the following web links:

- What is an e-portfolio: http://edin.ac/1aG0WOx
- Embedding PebblePad into the curriculum: http://edin.ac/1aG0Y93
- How to access PebblePad: http://edin.ac/1blyD4Y
- PebblePad resources for Staff: http://edin.ac/1blyNZZ

Additional University of Edinburgh Pebble+ support items for students can also be found using the following web links:

- Using Pebblepad: http://edin.ac/1aJbbUM
- How to access PebblePad: http://edin.ac/1blyD4Y
- Pebblepad resources for Students: http://edin.ac/17ATJNT